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Introduction 
 
1.1 Purpose and Functions 
 

The EIA-176 Query System is a PC-based system for users to produce reports and 
extract data from the EIA-176 database that is used to produce the Natural Gas Annual.  
Its purpose is to provide users with company-level data. This information is available in a 
format similar to the survey form for individual companies, as well as in files suitable for 
tabular calculation.  
 
The query system has two functions. • The first is to provide individual company 
responses in a form that resembles the EIA-176 survey form. This is viewable on-line, 
and available in a printed form. Appendix A shows a sample EIA-176 form. Each 
respondent is available in the year they reported data on the form EIA-176.    
 
• The second function is to provide files of EIA-176 data for use with other software 
packages. The query system provides two methods to obtain tabular data. (1) a set of 24 
pre-selected queries.  The information in these queries was designed to satisfy the bulk 
of data requests received by the EIA. Appendix B outlines the pre-selected queries and 
their data items. And;  
 
(2) The second method is for user-selected queries. These queries offer users the ability 
to access sets of data items not included in the pre-specified queries. Appendix C 
outlines the available data items. Data in the pre-selected and user-selected queries 
includes adjustment entries made by EIA staff to ensure that EIA-176 and publication 
data balance. 
 
Data sets from both query methods can be saved to separate files in a variety of popular 
formats that include: text, comma-delimited for spreadsheets, SDF files for use with 
dBase, and fixed width format for use in other software packages.  
 
New in the pre-selected query section is a report of Name/Address data, a report 
detailing individual company items shown in the continuation pages of the form, and LNG 
activity.  
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1.2 Hardware and Software Requirements 

 
The minimum hardware requirements needed to install and use the EIA-176 Query 
System are:   

   •An IBM-compatible personal computer (PC) – minimum Pentium 75 is suggested and 24 
MB of RAM 

 •The Windows operating system 95, 98, 2000, XP or NT –4.0 Service Pack 3 or later* 
 •Internet Explorer 5.0 or higher 
 •An 80-column monitor 
 •15 MB of hard-drive space 

 
* - See the ‘Getting Started’ document for notes about installing and using the EIA-
176 Query system with Access 2003. 

 
2.0 Installing the Query System 
2.1 Installing the EIA-176 Query System 
 
To install the EIA-176 Query System on your PC:  

1) Download the software from the EIA web site.  
2) Open Windows Explorer and find the file. The name will depend on which version was 

selected.   
3) Double click on the file and follow the instructions. 
4) As the installation begins, a ‘Welcome’ screen is displayed. Click the ‘Next’ button to 

continue.  
5) The ‘Select Destination Directory’ screen will be displayed. Click the ‘Next’ button if you 

wish to continue the installation to the default directory – C:\Program Files\EIA176Qry. If 
you wish to change the default directory, click the ‘Browse’ button.  

6) The ‘Ready to Install’ screen will be displayed. To continue with the installation click on 
the ‘Next’ button.  

7) A progress bar will appear. 
8) When the installation is completed the ‘Installation Completed’ screen will be displayed.  
Note: In some instances you will be prompted to re-start you computer to complete the 
installation. This is normal and can be done immediately to use the query system, or later if 
so desired.  
 

2.2 Starting the EIA-176 Query System 
 
The query installation program creates a program group and a desktop icon for the EIA-176 
Query System. The desktop icon starts the query system up immediately and appears on the 
desktop after the install program runs. 
 
2.3 Compressing the File for best performance 
 
The program group, which is available through the START menu has the EIA-176 Query System 
icon, as well as an option to Optimize (Compact and Repair) the query system.  If you run a lot of 
queries and get unpredictable behavior from the application you should optimize the database. 
 
 
 
The Optimize option should be run periodically so that the query database does not become 
fragmented.  In the Access 2000 version the compact and repair option is available from the File 
Menu.  
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In Access 2000 or above run the Compact and Repair from the File menu. 
 
 

 
 In the Access 97 version use the Optimize Database option from the Program Group to repair 
the database.  
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3.0 Using the Query System 
 
After a successful installation you can use the query system to print off individual company 
submissions or to generate data files from your Windows desktop by clicking the  START button, 
then the Programs button.  If your are using Access 2003 please see the “Getting Started” 
document for a description of some warning screens you may encounter.  Select the EIA 
Applications items, and then click EIA-176 Query, and the Main Menu Screen of the query system 
is displayed, as show below:  
  
3.1 Main Menu 
 

 

The three main options available in the EIA-176 Query system are accessed via this menu. They are: 
 

1) View EIA-176 Respondents: Click this to choose individual respondents and view or print their 
submissions 

 
2) Query EIA-176 Data: Click this to choose pre-selected or user selected queries which will allow the user to 

save data to PC-compatible files 
 
3) Exit: This ends the EIA-176 query. 

Each option is described in the sections that follow. 
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3.2 View EIA-176 Respondent  
 
3.2.1 Select a Company 
 
After clicking the View EIA-176 Respondents button on the Main Menu, the following Choose 
EIA-176 Company Screen is displayed. 
 

1) Select the report year first. 
2) Select the retrieval method 
 

 

 

 

 
If you select a company by name you will see a list of EIA-176 company names. If you select a 
company in a state you will get a list of states. The companies will appear after you select a state. 
 

 
 

 
 
3.2.1.1  Select a Company in a State  
 
If you Select a Company in a State you’ll see a list of states 

 

Highlight the state(s) you want and use the single right pointing arrow  located  in-
between the two white boxes to move the state to the selected box.  
 
To unselect a state use highlight it in the selected (leftmost) box and use the single left 

pointing arrow  to move the state out of the selected box.  
 
Once you’ve selected a state click on the Select Company button to see available companies 
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within that state.  
 

Use the mouse to select the company you want to view in the Companies available box. Click the 

right pointing arrow to move it to the selected box on the right.    
 
3.2.1.2 Select a Company by Name  

 
El Paso Natural Gas has been selected.  
 
3.3.2 View and Print EIA-176 Respondent Submission 
 

To view the submissions click the View=> button.  
 

To print the submission without previewing it click the Print Selection button.    
 

View Respondent result – Preview screen 
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You can maximize the preview screen by clicking on the resize button in the upper right corner.  

 
 
You can view subsequent pages of the preview screen by clicking the navigation buttons at the 
bottom of the screen.  
 

 
 
The right pointing arrow > takes you to later pages. 
 
The right arrow with the bar >| takes you to the last page.  
The left pointing arrow < takes you to earlier pages. 
The left arrow with the bar |< takes you to the first page.  
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3.2.2.1 View EIA-176 Company Menu 
 
The  View EIA-176 Company Menu lets you control this display.  

 
 

 – Closes this application. 

  – Allow you to choose a printer and set the page orientation (portrait works best). 

 – Changes the magnification of the report.  

       – Sends the report to the printer. 

      – Closes this report and either shows the next report if you’ve selected more than 
one, or returns you to the Choose Company screen.  
 
Once you’ve returned to the Choose Company Menu you can exit this function by clicking on the 
<=Return button.   
 

 
 
This will return you to the Main Menu. 
 
3.2.2.2 Choose Company Arrow Functions 

 
Below is a summary of what the arrow buttons in the Choose an EIA-176 Company 
do:  
 

 

 
Moves the highlighted item in the left box to the right box. 
 
Move all the items in the left box to the right box. 
 
Moves the highlighted item in the right box to the left box. 
 
Move all the items (highlighted or not) from the right box to 
the left box.  
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3.3  Query EIA-176 Data 
To view, select the Query Menu from the Main Menu.  
There are two query options: Pre-selected, and User-selected.  
 

 
 
The Pre-selected Queries option offers 24 queries that can be run on all or selected companies. 
The queries and the data items they include are detailed in Appendix B.  
 
The User-selected Queries option allows users to select other EIA-176 data items for inclusion 
 in data fields. They have a structured format. The rows will always be EIA-176 companies; users may 
 select column data values.  
 

The following sections will describe these two options. 
 
 
3.3.1 Pre-Selected Queries  
 
Pre-selected queries are queries whose conditions have already been created. These queries save  
the user the trouble of having to set the desired conditions each time he/she wishes to run the pre-set query. 
 
The following pre-set queries are available:  

Sorted by:  
State 
Volumes by sector (sales + transported) 
Prices by sector 
Rankings, by volume, national, and within States 
Type of Operations 
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Other: 
Detailed data on continuation lines.  

 
The first step in the pre-selected queries is to choose the year and company(s) you want to query. 
 
3.3.1.1 Select a Company Screen  
The Select Company screen for the queries is quite similar to that described in the View Respondent option 
which is described in section 3.3.1.  
 
Begin by selecting a year in the ‘Please enter a report year:” .  
 
 
You can select EIA-176 companies to include in your queries. If you want all companies choose the Select All 
Companies option, this retrieval method does not appear on the View Respondents menu.  This will close this 
screen and go to the select queries screen. 
 
The same white boxes that were used in the view respondent data are used here. If you Select a Company in a 
State you’ll see a list of states to choose from. 
 
Once you’ve made your selections click the Next=> button to select a query to run.  
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A detailed description of each pre-selected query can be obtained by highlighting the query title. The description 
appears in the box titled Query Description. The units the query will display in are shown in the Query Units box. 
 
Once you’ve selected a query by highlighting it, click the Run Query=> button to execute the query.  
 

 
 
The status bar is displayed at the bottom of the screen while the query is running. Some queries take a few 
moments to be displayed.  
 

 

 
 
Query output is displayed in a grid on your screen. 
 
3.3.1.3 EIA-176 Query Menu Functions 
 
Menu items at the top of the screen are used to filter output, or export to other data formats.  
 

 
 

The blue bars 
show query 
progress. 
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File 

 

 
loseC  – Closes the query grid. 

Save As/Export –Saves the data to another file 
Page Setup – lets you choose print settings 
Print Preview – Shows what a printout will look like 
Exit – Quits the Query system. 
 

 
lose – Exits the select query window. 

ediate box. 
C
Save As/Export - option opens an interm

 
After you choose this option you will be presented with an initial ‘Save As’ dialog box. Select the 

ote: This will look a little different depending on the version of MS Access that you are using. 

‘To an External File or Database’ option, and click the OK button. You will not be able to access 
your file if you choose the ‘Within the Current Database’ option. 
 
N
Under Windows XP and Access 2002 the Export screen will look as follows: 
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Next you will be presented with a Windows dialog box. Headers may look better when you select 
Save Formatted. 
You can put your own name into the File Name box.  
 

 
Different file type options are available by pulling down the ‘Save as File Type’ list box as shown. 
By scrolling down the list of available file types you can choose dBase formats also. 
Once you’ve named your file and selected the file type to save as click the Export button to finish 

Text files may save more successfully by 
checking the Save Formatted box.  
If you save Excel files with this option the 
headers look nice when you open the file 
in Excel. 
 
If you get the message EXTERNAL 
TABLE ISN’T IN EXPECTED FORMAT 
click the Save Formatted option. 
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the operation.   
 

Page Setup 
This option lets you set print settings and page orientation. 

 
Most query output looks best with the print orientation Landscape. This can be selected from the 
Page tab. 
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Print Preview  
 

 
The Print Preview buttons lets you see what the printout will look like.  

Print 
 
The Print button prints the grid off. Some of the queries may be large.  
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To use the Copy option the grid or column needs to be highlighted. The entire grid can be 
highlighted by clicking in the upper left corner (circled). Individual columns can be highlighted by 
clicking in the column header.  
 
To use Find, select just one column by clicking on the column header. The ST column is 
highlighted in this example. 
 

 
With the column selected pull down the Edit menu and click on the Find option. 
 

 
 
A dialog box will appear. Enter the value you wish to search for. After you’ve centered the value 
you want to find click either Find First, or Find Next. The grid will advance to the found value or tell 
you that no values exist.  
 

Click in the 
circle to 
highlight the 
entire grid. 
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Datasheet  

 

Font - adjusts the type in the grid 
Freeze columns  -makes the frozen column 
always appear 
Sort Ascending/Descending - sorts the data in 
the grid by the selected column 
Advanced Filter - lets you enter some simple 
criteria for data in the query. 
Apply Filter - is used in conjunction with 
Advanced Filter 
Remove Filter/Sort – removed the Applied 
Filter 

 
 Datasheet items allow you to manipulate the query that you’ve run. 
 
 
The Font menu item changes the font of the data in the grid. 
 

 

 

 

 
In this example, selecting Bold turns all the items bold.  
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The Freeze column options lets you always display one column on the screen. 
To freeze columns place your cursor in the column you wish to always view. In this example that column is 
COMPANYNAME. 
 

 

 
 

 

Pull down on the Datasheet menu item and click Freeze columns.    
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The COMPANYNAME column always 
appears at the left. Even when scrolling to the 
right, COMPANYNAME stays on the screen: 

  

 
 
Columns can be ‘unfrozen’ only by exiting the query grid.  
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To use the sort ascending feature select a column by clicking on the column heading. Pull down the Datasheet 
menu and click on Sort Ascending. The query will be sorted according to the values in the selected column. 

 
In the example above the ResVol values are sorted in ascending order, starting with zero. 
 
Sort descending works the same way. 
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With sort descending the largest values appear first.  
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To use the Advanced filter option no rows need to be selected. Just pull down the Datasheet menu and click on 
the Advanced filter option. 
 
The filter design window will appear. 

This window can be resized by 
stretching the edges.  
 
1) The first step is to copy the field 
you want to search from the field 
list into the criteria grid. 
 
 
You can either drag the name of 
the column you want to search or 
sort by in the upper pane of the 
window into the criteria grid in the 
lower pane of the window, or 
double click on a field to copy it to 
the next available field cell in the 
grid. 
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2) By clicking on the Field column in the lower pane 
you can get a list of fields in the query.  

 

 

3) In this example 
we’ve selected the 
RVol field. 
You can pull down  
the sort cell and 
specify a sort order 
if you want. 

 

4) In the Criteria cell 
we’ve entered a 
condition that Rvol 
be greater than 
900000. 

 

5) Click on the 
Apply/Filter Sort 
toolbar button when 
you’re ready to apply 
the filter. Any records 
that don’t meet the 
criteria you specified 
will disappear from 
the view. They have 
been filtered out. If 
you click on the 
Remove Filter/Sort 
button they will 
appear again. 
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6) The rows that appear should meet the criteria. A note: on full survey datasets it helps to have plenty of 
memory available. If you run a filter and nothing changes you may not have enough memory to process.  

 
If you have enough memory, you are not limited to one field or value.  You can select several fields in the 
criteria grid.  The EIA-176 Query system offers standard operators  

= 
>  
< 
>= 
<= 
<> 
 

Equals 
Greater than 
Less than 
Greater than or equal to  
Less than or equal to  
Not 

 

 

To specify AND/OR criteria place the operators in different rows of the criteria grid.  

 

To express AND criteria within a single field use the 
AND operator 
 
This filter asks for a State value of TX AND MI. 

 

To express AND criteria between fields put each 
criteria on the same row of the criteria grid. 
 
This statement asks for ST equal to TX and Rvol > 
90000.  
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To express OR criteria within a single field use the 
OR operator. 
 
This statement asks for ST equal to TX OR MI 

 

To express OR criteria between multiple fields place 
the criteria on separate rows of the criteria grid. 
 
This statement asks for ST equal to TX or Rvol > 
90000. 
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3.3.2 - Custom Queries 
The Custom Queries option allows you to choose individual data items from the entire EIA-176 for inclusion in 
datasets. The methods are similar to those used in the Pre-selected queries. 

 
 
3.3.2.1 View EIA-176 Company Menu 
 
First you will be prompted to select Companies and Year.  This screen is similar to the Company selection 
screen in other parts of the query.  
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After you’ve selected companies and the year, you will go onto the Select Reported Data Items button. You’ll be 
presented with a list of EIA-176  form data lines to pick from 
3.3.2.2 Pick Reported Lines 
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Each line 
item with 
data from 
the form is 
represented 
with a short 
description. 
The Part 
and Line 
Number is 
also 
included. 
The 
highlight 
method is 
similar to 
that in the 
Company 
screen. 

Once all your selections have been made click Finished Selecting. 
 
The items are labeled like the lines on the survey form. If you select the ‘Natural Gas Survey Forms’ hyperlink 
you’ll be taken the Natural Gas survey form page, and can view a copy of the EIA-176 survey form and 
instructions. If you have questions about which items you want to see this can be useful.  
 
 
 
 
The units of the survey items are available in the Selected Items box after you select them: 

 
 

 EIA-176 Query System 11/14/08 - 30 of 42



EIA-176 Query System User’s Guide  11/14/08 

 
 
3.3.2.3 Select Quantities and Build Calculated Items  
 

  
 
The Select Quantities and build Calculated Items screen has three parts.  
Aggregate functions 
Select Company Available Quantities. 
Calculated field.  
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Available Quantities:  

 
 
For each line item you select this portion of the screen will have a row.  
The Available Quantities portion shows you what quantities are available for this item.  
The Quantities to include portion allows you to include or exclude quantities. 
.  
For this example, if you aren’t interested in the Number of Consumers for deliveries to 
Residential Sales, you would use the mouse to deselect that item, and it won’t appear in your 
query data file. 
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Type Of Operations 
 
You can select multiple Types of Operations if you choose. 
 
 If no selection is made, all types are included. If they are all included they are not identified. 

 

Aggregate functions 

 
The Aggregate functions provide summary statistics for all the companies selected. The 
Aggregate functions, the Type of Operations, and the Add calculated functions are mutually 
exclusive.    
 

 
 
In the following example the Aggregate function has been grouped by Delivered to Consumers 

 
When you 
select 
Aggregate 
functions 
other 
options 
become 
disabled. 

 

The 
results of 
the query 
with sum 
aggregate 
function. 
Notice 
that the 
column 
headers 
all start 
with Sm – 
for Sum. 
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The File menu provides your query output options.  
Close – closes the query and returns you to the 
selection screen. 
 
When you return to the selection screen your 
company, year and data item selections will still be 
in place. Any aggregate functions will be cleared. 

 
 

 
To Add a Calculated Field make your quantity selections first, and don’t select an Aggregate function. Then 
click on the Add a Calculated Field button.  This opens another window. 
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Choose variables from this list. 
 
 
 
Your expression will appear here. 
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When you click on a variable in the  
Available box, then it will appear in the expression 
box. 
 
 
Click on operators to specify 
your calculation. 
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Once 
you’ve  
built your 
expression, 
click on 
 Complete 
Expression 
to finish.  

 

You must name your 
expression in 
the Enter a Column 
Name box. 
 
 

 
If you want to add another expression click add Another Expression=>.  
The expression box will be cleared out and you can start another expression. Your first expression will be  
held for the query.  
When you are finished, click Finished=> Run Query. This will immediately run the query. 
 
Note: you can click and edit the expression in the expression box. 

 
The columns have been resized and hidden (by clicking in the column headers) to show the TOTAL variable. 
It is the sum of DLResSalVol And DlComSalVol.  
 
Because the columns were edited in the datasheet, this prompt appears after choosing the Close option 
from the File Menu. Dynamic_Query is where user selected-queries are temporarily stored. It does  
not matter if they are saved or not. 
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After you close the query you’re returned to the Select Quantities and build Calculated Items  
Menu.  
 

 
To run the query you just constructed again you can click Run Query.  
 
Exit returns you to the main queries menu.  
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Appendix A – EIA-176 Survey Form 
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Appendix B – Pre-Selected Query Items 
 

Query description Query Memo 
Answers to Question in 
Part II about Alternative 
Fuel Vehicles 

This Query has the answers from companies on Part 3. 
This data is only available in 2005. 

All Respondent Type of 
Operations and Sector 
Items. 

This Query has Part III of the form, Types of Operations, 
which the associated consumption sector items by 
respondent.  

All Part IV & V Items 
(Volumes) This Query has all Part IV & V Volume items. 
All Part VI Items 
(Volumes, Costs) This Query has all Part VI Volume and Cost items. 
All Sector Items 
(Volumes, Costs, 
Consumers) 

All consumption items by part and line number. In an easy 
to pivot format for Excel. 

All Sector items sorted by 
state 

This query includes company data sorted by state for lines 
10.1 thru 10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 
Volumes and Number of Consumers are available for all 
lines. Costs are only available for lines 10.1 thru 10.4, and 
10.6. 

Sector Sector Prices 
Consumption Sector Prices in an easy to pivot format for 
multiple years 

Residential Sector 
Volumes - Delivered, 
Transported, Total 

Residential sector volumes - delivered, transported and 
total. 

Company Name 
Information 

This query includes the Company Name, State of 
Operation and the Type of Operations category they 
reported. 

Commercial Sector 
Volumes 

Commercial sector volumes - delivered, transported and 
totals. 

Detail level Continuation 
Lines 

This query shows continuation lines with the company 
reference for Parts 4 & 5. 

Interstate Movement 
Lines (3.0 and 14.0) 

This Query shows lines 3.0 and 14.0. It can be pivoted in 
Excel to replicated Table 12 from the Natural Gas Annual. 

Industrial Sector Volumes 
Industrial sector volumes - delivered, transported and 
totals. 

Footnotes and Associated 
Data Values 

This query shows data values and associated footnotes 
for selected companies. 

Sector Vols sorted by 
sector 

This query includes company data sorted by sector -
Residential, Commercial, Industrial, Electric, and Vehicle 
Fuel . The query includes volumes with delivered and 
transported items. 

Electric Sector Volumes Electric sector prices - delivered, transported, and totals. 

Sector Vols ranked 
nationally 

This query includes  company data sorted by volume 
amounts. Consumption delivered to consumer items - 
lines 10.1 thru 10.4, and 10.6 are added to consumption 
transported items -lines 11.1 thru 11.4 and 11.6 to rank 
companies nationally. 

Vehicle Fuel Volumes Vehicle Fuel Volumes - delivered, transported and totals. 
Total Delivered including 
176 Electric This query has sectors including electric. 
Sector Vols ranked by This query includes Company data sorted and ranked by 
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Query description Query Memo 
state volume amount by state. Consumption delivered to 

consumer items -lines 10.1 thru 10.4, and 10.6- are added 
to consumption transported items -lines 11.1 thru 11.4 and 
11.6. 

LNG & Underground Gas 
Storage 

This Query has LNG and Underground Storage Injections 
& Withdrawals, as well as LNG Inventory at the end of the 
year. 

Sector Prices sorted by 
sector 

This query includes prices for consumption data - lines 
10.1 thru 10.4, and 10.6 - only. Costs are not collected for 
transported consumption sector. 

Sector Vols for Investor 
Owned Distribution 
Companies 

This query includes only companies who checked A on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for 
Municipally Owned 
Distribution Companies 

This query includes only companies  who checked B on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4 and 10.6. 
who checked B on Section II. Type of Operations. 
 It covers lines 10.1 thru 10.4, and 10.6  
and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Privately 
Owned Distribution 
Companies 

This query includes only companies who checked C on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for 
Cooperatively Owned 
Distribution Companies 

This query includes only companies who checked D on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Other 
Distribution Companies 

This query includes only companies who checked E on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Interstate 
Pipelines 

This query includes only companies who checked F on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Intrastate 
Pipelines 

This query includes only companies who checked G on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Storage 
Operators 

This query includes only companies who checked H on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Synthetic 
Natural Gas Plant 
Operators 

This query includes only companies who checked I on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Producers 

This query includes only companies who checked J on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Gathers 

This query includes only companies who checked K on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Liquefied 
Natural Gas (LNG) 
Operators 

This query includes only companies who checked L on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 

Sector Vols for Other 
Operators 

This query includes only companies who checked M on 
Section II. Type of Operations. It covers lines 10.1 thru 
10.4, and 10.6 and lines 11.1 thru 11.4 and 11.6. 
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Appendix C – User Selected Query Item names 
 

UserQueryName UQPart UQLin
Number of Alternative Fuel Vehicles 3 3014 
Gas Produced onsystem by company 4 0110 
 Synthetic natural gas produced 4 0120 
 Underground Storage Withdrawals 4 0210 
 Received from LNG 4 0220 
Other Storage Withdrawals 4 0230 
Transported into rpt ST from:  ST or Cntry 4 0300 
Receipts at City Gate 4 0400 
Other Receipts 4 0500 
Supplemental Gasous Fuels 4 0600 
Total Supply 4 0700 
Inventory of LNG 5 0800 
Heat Content of consumer deliveries 6 0900 
Del to Residential Sales 6 1010 
Del to Commercial Sales 6 1020 
Del to Industrial sales 6 1030 
Del to Electric Utility Sales 6 1040 
Del fo Vehicle Fuel 6 1050 
Del to Other (see footnotes for type) 6 1060 
Trans to Residential Consumers 6 1110 
Trans to Commercial Consumers 6 1120 
Trans to Industrial Consumers 6 1130 
Trans to Electric Utilities 6 1140 
Trans for Vehicle Fuel use 6 1150 
Trans to Other (see footnotes for type) 6 1160 
Pipeline Compressor Use 6 1210 
New Pipeline Fill 6 1220 
Distribution Company Use 6 1230 
Other (see footnotes for type) 6 1240 
Underground Storage Injections 6 1310 
Liquefied natural gas (LNG) Injections 6 1320 
Other Storage Injections (see footnotes for type) 6 1330 
Trans to State Line: Comp ST/Cntry 6 1400 
Lease Use 6 1500 
Returned to oil and/or gas reservoirs 6 1600 
Losses from leaks, migration, damage and/or 6 1700 
Other Disp: Distribution Companies 6 1810 
Other Disp: Other Pipelines 6 1820 
Other Disp: Storage Operators 6 1830 
Other Disp: Other (Specify type) 6 1840 
Total Disposition 6 1900 
Unacc't for gas supply 6 2000 
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